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Introduction
          The SQL data administrator is based on the ODBC (Open Database Connectivity) technology 
supplied by Microsoft.    ODBC allows applications to connect to SQL databases,    submit SQL requests 
and retrieve results.    It provides a standard call-level interface that will work across multiple database 
vendor platforms.    An application that uses ODBC properly can perform its database operations in a 
consistent manner against any vendor platform without having to be re-compiled or changed in any way. 
This cross-platform functionality is accomplished by using special programs called ODBC drivers.    They 
handle all the vendor-specific details for a particular platform or group of platforms.    ODBC applications 
choose    which driver to use at connect time by specifying the name of an ODBC data source. Data 
sources are defined in the ODBC.INI file which resides in the Windows directory.    The Driver Manager 
program from Microsoft should be used to browse and maintain this file.    It's accessible from the 
Windows Control Panel and should be on any PC that has an ODBC driver properly installed. 



ODBC Data Source List
This is a combo box located at the top of the frame window on the toolbar.    It's loaded with the names of 
all active data sources found in the catalog table DataSource.    When the current child window is 
connected,    the name of the connected data source is displayed in the combo box.    It can be refreshed 
by selecting the Refresh Driver Information option from the Catalog Menu.



Connect Button
This is a graphical command button located at the top of the frame window on the toolbar.    The picture 
on the button represents the current connection status of the active child window.    When the active child 
window is not connected and the button is clicked,    the program will attempt to connect to the data 
source selected in the ODBC Data Source List.    When the active child window is connected and the 
button is clicked,    the program will attempt to disconnect from the current data source.



Status Bar
This is a text label at the bottom of the frame window that occupies the entire width of the frame window. 
It's used to display information and help messages to the user at run time.    The help messages can be 
turned off in the General Options.
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General Information
The Data Definition Window is a split window made up of a hierarchical list display on the left side and a 
normal list on the right that displays the contents of the item selected in the hierarchical list. 

To Re-size the display lists

1. Position the mouse cursor between the two lists.    The cursor should change from the "arrow" 
shape to a "splitter" shape. 

2. Press and hold the left mouse button. A vertical "splitter bar" should appear.

3. While holding the left mouse button,    move the mouse left or right.    The "splitter bar" should 
move left or right with the mouse.

4. When the "splitter bar"    is in the desired position,    release the left mouse button.    The position 
of the "splitter bar"    when the button is released becomes the new divider between the lists.



Hierarchical Display List
The Hierarchical Display List is located on the left side of the Data Definition Window. Its purpose is to 
provide a hierarchical display of the objects contained in a connected data source. 

Action List - 

Selecting Items - Items are selected by clicking them with the left button of the mouse.    Selecting 
an item will display the children for the selected item in the Selection Display List.

Expanding/Contracting List - Double-clicking a closed-branch item will display the children for 
the item in the directly under the parent in the Hierarchical    Display List indented at the next 
level.    Double-clicking an open-branch item will close the branch and hide the children. 

Drag and Drop - Table level objects can be dropped to the list. Objects cannot be dragged from it. 
Holding the SHIFT and CTRL keys down when dropping will preset options for the Move/Copy 
Tables dialog.

Right Mouse Button - When the right mouse button is clicked in the list,    the names of the 
currently selected objects are copied to the clipboard.

Delete Key - This command attempts to delete the selected objects in the Selection Display List.    If 
no objects are selected there,    The currently selected table object will be deleted.    Pressing the 
delete key has the same effect as the selecting the Delete option from the File Menu .

        List objects are currently displayed at four levels. 

1.        The name of the connected data source the window is currently connected to.

2.        All the TableOwner names found in the catalog database for the current data source.    The 
word "NULL" is displayed as the only name when no TableOwner names are found.

3.        All the TableName entries found in the catalog database for the currently selected TableOwner.

4.        All the ColumnName entries    found in the catalog database for the currently selected 
TableName.



Selection Display List
The Selection Display List is located on the right side of the Data Definition Window.    Its purpose is to    
provide a display of the child objects available for the currently selected item in the hierarchical display. 

Action List - 

Selecting Items - Items are selected by clicking them with the left button of the mouse. Multiple 
items can be selected by holding the SHIFT and CTRL keys down while clicking the left mouse 
button.

Expanding/Contracting List - Double-clicking a TableOwner or TableName item in the list will 
cause the item clicked to be found and selected in the Hierarchical Display List,    expanding the 
tree branch if necessary.    When the new item is selected in the Hierarchical Display List,    its 
children are displayed in the Selection Display List.

Drag and Drop - Table level objects can be dragged from the list and dropped to a Data Definition 
Window    or a Query Window.    Holding the SHIFT and CTRL keys down when dropping will 
preset options for the Move/Copy Tables dialog when dropping to a Data Definition Window.

Right Mouse Button - When the right mouse button is clicked in the list,    the names of the 
currently selected objects are copied to the clipboard.

Delete Key - This command attempts to delete the selected objects.    If no objects are selected.    
The table object selected in the Hierarchical Display List will be deleted.    Pressing the delete key 
has the same effect as the selecting the Delete option from the File Menu .



Menu Options 
File Menu
Edit Menu
View Menu
Catalog Menu
Option Menu



File Menu 

New Data Definitions

This creates a new,    un-connected    Data Definition Window.    To connect,    select a data source from 
the ODBC Data Source List and click the Connect button.

New Query

This creates a new,    un-connected Query window.    To connect,    select a data source from the ODBC 
Data Source List and click the Connect button.

New Database

This opens a filename selection dialog and creates a new Access 1.1 (.MDB) database file from the 
selected filename if the Ok button is clicked.    The program will then optionally add the new database to 
ODBC.INI as a new data source.

Add Access Data Source

This opens a filename selection dialog and adds the selected    Access 1.1 (.MDB) database file to 
ODBC.INI as a new data source.

Delete

This deletes the selected objects from the connected data source.

Run Driver Manager

This executes the ODBCADM.EXE program.    This is part of the ODBC software development kit.    It's 
used to add and configure ODBC data sources.    This menu option can also be executed by clicking the 
right mouse button on the ODBC Data Source List.

Exit

This disconnects all connected windows and exits the program.



Edit Menu

Copy

This copies the names of the selected Selection Display List items to the clipboard.

Column Definitions

This invokes the Edit Column Definitions dialog.    This is a modal dialog used to create new tables and 
change existing table structures on the currently connected data source.



View Menu

Sort Columns by Alpha

When this option is checked,    column names in the Selection Display List are sorted in ASCII alpha order 
by their names.

Sort Columns by Create Order

When this option is checked,    column names in the Selection Display List are sorted in the order of their 
retrieval from the data source.    This is usually the order the columns were created in.

Sort Tables by Alpha

When this option is checked,    Table names in the Selection Display List are sorted in ASCII alpha order 
by their names.

Sort Tables by Type

When this option is checked,    Table names in the Selection Display List are sorted in ASCII alpha order 
by their type names. 



Catalog Menu

View Table Information

This displays the contents of the catalog table SQLTables.    The program will use the active child window 
to do this if it's an un-connected Query Window with an empty SQL Text Buffer. 

View Column Information

This displays the contents of the catalog table SQLColumns.    The program will use the active child 
window to do this if it's an un-connected Query Window with an empty SQL Text Buffer.

View Data Type Information

This displays the contents of the catalog table SQLDriverTypeInfo.    The program will use the active child 
window to do this if it's an un-connected Query Window with an empty SQL Text Buffer.

View Driver Information

This displays the contents of the catalog table DataSource.    The program will use the active child window 
to do this if it's an un-connected Query Window with an empty SQL Text Buffer.

View Function Information

This displays the contents of the catalog table SQLFunctions.    The program will use the active child 
window to do this if it's an un-connected Query Window with an empty SQL Text Buffer.

Refresh Table Information

This refreshes the contents of the catalog table SQLTables.    The program does this by first deleting all 
rows in SQLTables    for the currently connected data source.    Then the program issues the ODBC 
function SQLTables on the connected data source and adds the resulting rows to SQLTables.    This 
should only be necessary when the catalog structure is modified from another program.

Refresh Column Information

This refreshes the contents of the catalog table SQLColumns.    The program does this by first deleting all 
rows in SQLColumns    for the currently connected data source.    Then the program issues the ODBC 
function SQLColumns on the connected data source and adds the resulting rows to SQLColumns    .    
This should only be necessary when the catalog structure is modified from another program.

Refresh All Connection Information

This refreshes the contents of the catalog tables SQLTables and SQLColumns as well as 
SQLDriverTypeInfo and SQLFunctions for the currently connected data source.

Refresh Driver Information

This refreshes the contents of the catalog tables DataSource and DataSourceParams.    It should be 
executed when the ODBC.INI file is changed while the program is running so the ODBCDataSourceList 
and proper catalog tables can be updated.    The program detects changes automatically at startup and 
refreshes the catalog database.

Remove Inactive Records

This option removes records for inactive data sources from SQLTables,    SQLColumns,    DataSource and 
DataSourceParams.    A data source is inactive when the ODBCDataSourceActive    flag is set to 'N' in the 
catalog table DataSource.    This indicates that the data source is not currently configured in ODBC.INI.    
This happens when data sources are removed with a driver manager utility or the catalog database file is 
moved between computers.    If this flag is set incorrectly,    it may mean that the ODBC.INI file has 
changed since the program was started.    If so,    run the Refresh Driver Information option to rebuild 
the table.



Option Menu

General Options

Selecting this option displays the dialog General Options.    This allows the user to store settings for 
various program options. 

Data Options

Selecting this option displays the Data Options.    This allows the user to store settings for various 
program options.



Query Window
General Information
SQL Text Buffer
Result Grid
Menu Options



General Information
The Query Window is a split window made up of a multi-line text buffer on the left side for editing SQL 
and a spreadsheet grid on the right side for displaying a result set from an SQL SELECT statement..    
Table level objects can be dropped to the Query Window to generate SQL in the SQL Text Buffer.

To Re-size the Query controls

1. Position the mouse cursor between the two controls.    The cursor should change from the "arrow" 
shape to a "splitter" shape. 

2. Press and hold the left mouse button. A vertical "splitter bar" should appear.

3. While holding the left mouse button,    move the mouse left or right.    The "splitter bar" should 
move left or right with the mouse.

4. When the "splitter bar"    is in the desired position,    release the left mouse button.    The position 
of the "splitter bar"    when the button is released becomes the new divider between the controls.



SQL Text Buffer
The SQL Text Buffer is a multi-line text box control on the left side of the Query Window where SQL code 
can be entered and edited.    The text can be saved and loaded to and from disk as DOS files with options 
on the File Menu.    If the window is connected to a data source,    the SQL can be executed by using the 
Exec SQL menu option.    If any text is selected,    only this text is sent to the data source for execution.

Action List - 

Drag and Drop - When table-level items are dropped into the buffer,    the program will generate 
SQL code and insert it at the top of the buffer.    If a single item is dropped,    the code will consist 
of a SELECT statement requesting all the columns and rows from the item.    If multiple items are 
dropped,    a SELECT statement will be generated that attempts to join the items dropped.    Join 
conditions are created using shared column names.

Right Mouse Button - When the right mouse button is clicked in the buffer,    the buffer text is 
copied to the clipboard.



Result Grid
The Result Grid is a spreadsheet-like control on the right side of the Query Window used to display result 
sets retrieved from the data source when a SQL SELECT statement is executed with the Exec SQL 
menu option on the Result Menu.    The maximum rows the grid will store is set in the dialog displayed by 
selecting the Data menu option in the Option Menu.

Action List - 

Drag and Drop - When table-level items are dropped into the grid,    the program will generate SQL 
code and insert it at the top of the SQL Text Buffer.    If a single item is dropped,    the code will 
consist of a SELECT statement requesting all the columns and rows from the item.    If multiple 
items are dropped,    a SELECT statement will be generated that attempts to join the items 
dropped.    Join conditions are created using shared column names.

Right Mouse Button - When the right mouse button is clicked in the grid,    the selected grid cells 
are copied .    When clicked on a column name,    the name is to the clipboard.



Menu Options
File Menu
Edit Menu
Catalog Menu
Result Menu
Option Menu



File Menu
New Data Definitions

This creates a new,    un-connected    Data Definition Window.    To connect,    select a data source from 
the ODBC Data Source List and click the Connect button.

New Query

This creates a new,    un-connected Query window.    To connect,    select a data source from the ODBC 
Data Source List and click the Connect button.

New

This clears the SQL Text Buffer.

Open

This loads the SQL Text Buffer with the contents of the selected disk file.

Save

This saves the contents of the SQL Text Buffer to the selected disk file.

Save As

This saves the contents of the SQL Text Buffer      to the selected disk file.

New Database

This opens a filename selection dialog and creates a new Access 1.1 (.MDB) database file from the 
selected filename if the Ok button is clicked.    The program will then optionally add the new database to 
ODBC.INI as a new data source.

Add Access Data Source

This opens a filename selection dialog and adds the selected    Access 1.1 (.MDB) database file to 
ODBC.INI as a new data source.

Run Driver Manager

This executes the ODBCADM.EXE program.    This is part of the ODBC software development kit.    It's 
used to add and configure ODBC data sources.    This menu option can also be executed by clicking the 
right mouse button on the ODBC Data Source List.

Exit

This disconnects all connected windows and exits the program.



Edit Menu
Copy

This copies the selected text in the SQL Text Buffer to the clipboard.

Copy From Result

This copies the selected cells in the Result Grid to the clipboard.



Catalog Menu
see Catalog Menu



Result Menu
Exec SQL

This executes the contents of the SQL Text Buffer on the connected data source.    If any text in the SQL 
Text Buffer    is selected,    only the selected text is sent to the data source for execution.    If any rows are 
returned,    they are retrieved and displayed in the Result Grid.

Grid View

This option displays the Grid View.

Stop/Resume Retrieving

This option toggles the loading of result rows in the Result Grid.    When the program is loading the results 
from a select statement,    the caption will be set to "Stop Retrieving".    Selecting the option at this point 
will stop the retrieving process.    The caption will then be set to "Resume Retrieving" and if clicked,    
loading will resume.



Option Menu
see Option Menu



Overview
The purpose of the Catalog Database is to store information about the current ODBC environment on the 
PC as well as information gathered from the ODBC data sources themselves.    All tables are populated 
automatically by the program at connect-time for the data source connected to except for SQLColumns.    
Several menu commands from the Catalog Menu exist to refresh and view various parts of the database. 
The database is stored in the file INIDB.MDB in the directory where the product is installed.    It is 
automatically added to ODBC.INI as the data source INIDB.



Tables in the Database
DataSource
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DataSource
This table stores information gathered from the [ODBC Data Sources] section of ODBC.INI.    One row is 
stored for each DataSourceName.    Columns are as follows:

DataSourceName - A unique string identifier for the data source.    Each name is an entry in the 
[ODBC Data Sources] section of ODBC.INI.

ODBCDataSourceType - A string describing the external data format for the data source.    This is 
what each name entry from the [ODBC Data Sources] section of ODBC.INI is set to.

ODBCDataSourceActive - A flag field set to 'Y' if the data source is currently in the ODBC.INI file.    
The program will set the flag to 'N' when it sees that the data source has been removed.    This 
field is only updated when the program detects ODBC.INI changes at startup or when the menu 
option Refresh Driver Info option is selected from the Catalog Menu.



DataSourceParams
This table stores information gathered from the ODBC.INI sections for each data source name.    One row 
is stored for each IniFieldName in a particular DataSourceName.    Columns are as follows:

DataSourceName - A unique string identifier for the data source.    Each name is an entry in the 
[ODBC Data Sources] section of ODBC.INI.

IniFieldName - The entry name.

IniFieldValue - The entries' value.



SQLTables
This table stores information gathered from the ODBC function SQLTables for each data source 
successfully connected to with a Data Definition Window.    This table is loaded automatically    when the 
connecting if no rows are found for the data source.    Columns are as follows:

DataSourceName - A unique string identifier for the data source.    Each name is an entry in the 
[ODBC Data Sources] section of ODBC.INI.

TABLE_QUALIFIER - Table qualifier identifier.    NULL if not applicable to the data source.

TABLE_OWNER - Table owner identifier. NULL if not applicable to the data source.

TABLE_NAME - Table identifier.

TABLE_TYPE - Table type identifier.    This will be: "TABLE", "VIEW", "SYSTEM TABLE", "ALIAS", 
"SYNONYM" or a data source specific type identifier.

REMARKS - A description of the table.

ColumnsRetrieved - A time stamp field indicating the last time that columns were retrieved from the 
data source for this table.



SQLColumns
This table stores information gathered from the ODBC function SQLColumns for each data source 
successfully connected to with a Data Definition Window.    This table is loaded automatically    when the 
connecting if no rows are found for the data source.    Columns are as follows:

DataSourceName - A unique string identifier for the data source.    Each name is an entry in the 
[ODBC Data Sources] section.

TABLE_QUALIFIER - Table qualifier identifier.    NULL if not applicable to the data source.

TABLE_OWNER - Table owner identifier. NULL if not applicable to the data source.

TABLE_NAME - Table identifier.

COLUMN_NAME - Column identifier.

DATA_TYPE - ODBC SQL data type. For a list of valid ODBC SQL data types, see "SQL Data Types" 
in Appendix D.

TYPE_NAME - Data source-dependent data type name; for example, "CHAR", "VARCHAR", 
"MONEY", "LONG VARBINARY", or "CHAR () FOR BIT DATA".

PRECISION - The precision of the column on the data source. This value is the same as the 
LENGTH column for character or binary data.    Otherwise it is the display length for binary 
number data types e.g SQL_INTEGER or the digits left of the decimal for decimal number data 
types e.g SQL_NUMERIC.

LENGTH - The transfer size of the data; that is, the length in bytes of data transferred on an 
SQLGetData or SQLFetch operation if SQL_C_DEFAULT is specified. For numeric data, this size 
may be different than the size of the data stored on the data source. This value is the same as the 
PRECISION column for character or binary data. 

SCALE - The scale of the column on the data source. This is the number of digits to the right of the 
decimal for decimal number data types e.g SQL_NUMERIC.

RADIX - Either 10 or 2. If it is 10, the values in PRECISION and SCALE give the number of decimal 
digits allowed for the column. For example, a DECIMAL(12,5) column would return a RADIX of 
10, a PRECISION of 12, and a SCALE of 5.

If it is 2, the values in PRECISION and SCALE give the number of bits allowed in the column. For 
example, a FLOAT column could return a RADIX of 2, a PRECISION of 53, and a SCALE of 
NULL.

Note that, for numeric data types, the data source and driver can return a RADIX of either 2 or 10. 
For example, a FLOAT column could return a RADIX of 10, a PRECISION of 15 and a SCALE of 
NULL.

NULL is returned for data types where radix is not applicable. 

NULLABLE - Set to 1 if the column accepts NULL values.

REMARKS - A description of the column.

TableRetrivalOrder - The numerical order of the columns in the result set returned from the 
SQLColumns ODBC function.



SQLDriverTypeInfo
This table stores information gathered from the ODBC function SQLGetTypeInfo for each data source 
successfully connected to with a Data Definition Window.    This table is loaded automatically    when the 
connecting if no rows are found for the data source.    Columns are as follows:

ODBCDataSourceType - A string describing the external data format for the data source.    This is 
what each name entry from the [ODBC Data Sources] section of ODBC.INI is set to.

TYPE_NAME - Data sourcedependent data type name; for example, "CHAR", "VARCHAR", 
"MONEY", "LONG VARBINARY", or "CHAR (_) FOR BIT DATA".

DATA_TYPE - ODBC SQL data type. For a list of valid ODBC SQL data types, see "SQL Data Types" 
in Appendix D.

PRECISION - The maximum precision of the data type on the data source.    NULL is returned for 
data types where precision is not applicable.

LITERAL_PREFIX - Character or characters used to prefix a literal; e.g. a single quote ( ' ) for 
character data types or 0x for binary data types; NULL is returned for data types where a literal 
prefix is not applicable.

LITERAL_SUFFIX - Character or characters used to terminate a literal; e.g. a single quote ( ' ) for 
character data types; NULL is returned for data types where a literal suffix is not applicable.

CREATE_PARAMS - CREATE_PARAMS for DECIMAL would be "precision,scale", 
CREATE_PARAMS for VARCHAR would equal "max length"; NULL is returned if there are no 
parameters for the data type definition, e.g. INTEGER.The driver supplies the CREATE_PARAMS 
text in the language of the country where it is used.

NULLABLE - Whether the data type accepts a NULL value:

SQL_NO_NULLS if the data type does not accept NULL values.

SQL_NULLABLE if the data type accepts NULL values.

SQL_NULLABLE_UNKNOWN if it is not known if the column accepts NULL values.

CASE_SENSITIVE - Whether the data type can be treated as case sensitive for collations:

TRUE if the data type can be case sensitive.

FALSE if the data type cannot be case sensitive.

SEARCHABLE - How the data type is used in a WHERE clause:

SQL_UNSEARCHABLE if the data type cannot be used in a WHERE clause.

SQL_LIKE_ONLY if the data type can be used in a WHERE clause only with the LIKE predicate.

SQL_ALL_EXCEPT_LIKE if the data type can be used in a WHERE clause with all comparison 
operators except LIKE.

SQL_SEARCHABLE if the data type can be used in a WHERE clause with any comparison 
operator.

UNSIGNED_ATTRIBUTE - Whether the data type is unsigned:

TRUE if the data type is unsigned

FALSE if the data type is signed

NULL is returned if the attribute is not applicable to the data type.

MONEY - Whether the data type is a money data type:

TRUE if it is a money data type.



FALSE if it is not.

AUTO_INCREMENT - Whether the data type is autoincrementing:

TRUE if the data type is autoincrementing.

FALSE if the data type is not autoincrementing.

NULL is returned if the attribute is not applicable to the data type.

An application can insert values into a column having this attribute, but cannot update the values 
in the column. This attribute is valid only for numeric data types.

LOCAL_TYPE_NAME - Localized version of the data source-dependent name of the data type. 
NULL is returned if a localized name is not supported by the data source.



SQLFunctions
This table stores information gathered from the ODBC function SQLGetFunctions for each data source 
successfully connected to with a Data Definition Window.    This table is loaded automatically    when the 
connecting if no rows are found for the data source.    Columns are as follows:

ODBCDataSourceType - A string describing the external data format for the data source.    This is 
what each name entry from the [ODBC Data Sources] section of ODBC.INI is set to.

FunctionName - The ODBC function name supported by the ODBCDataSourceType.

ConformanceLevel - The ODBC compatibility of the function.    Either 'CORE' for a core function,    
'EXT1' for an Extension 1 function    or 'EXT2' for an Extension 2 function.



Edit Column Definitions
Overview
Dialog Controls



Overview
The Edit Column Definitions dialog is used to create new tables as well as change the structure of 
existing tables.    The dialog operates in both a "table create" mode and a "table edit" mode.    Edit mode is 
used to add new columns to and drop columns from tables that already exist assuming this is supported 
by the data source.    Create mode is used to create new tables.    Edit mode is the startup mode for the 
dialog and is re-entered when a new item is selected in the "Table Names" combo box.    Create mode is 
entered when a new name is typed into the "Table Names" combo box.



Dialog Controls
Column List - In Create Mode,    these are the columns that will be put into the table created.    In Edit 

Mode,    these are the columns that exist in the currently selected table.    This list is reloaded and 
Edit Mode is entered when a new name is selected in the "Table Names" combo box.

Add Button - This button is enabled by typing the name of a new column into the "Column Name" 
edit box.    In Create Mode,    clicking the Add button will add the new column to the Column List 
using the current Column Information settings.    In Edit mode,    clicking the Add button will submit 
the SQL statement ALTER TABLE to add the new column.

Drop Button - This button is enabled by selecting a list item from the "Column List".    In Create 
Mode,    clicking the Drop button will remove the current column from the Column List.    In Edit 
mode,    clicking the Drop button will submit the SQL statement ALTER TABLE to remove the 
column.

Create Button - This button is enabled by typing the name of a new table into the "Table Names" 
combo box..    Clicking the Create button will add the new table to the connected data source with 
the SQL statement CREATE TABLE.    Information about each column put into the new table 
comes from the "Column List" and the "Column Information" control settings.

Column Information Controls - These display column information such as length and data type for 
the currently selected column from the "Column List" or the column to be added depending on the 
status of the "Add" and "Drop" buttons.



Move/Copy Tables
Overview
Selection Display/Change Controls
Status Indicators
Command Buttons



Overview
The Move/Copy dialog is invoked by dropping table level objects onto a connected Data Definition 
Window.    It's purpose is to copy column definitions and table data between connected data sources.    
Only table and view object types can be copied.    View object DDL is not copied to the destination data 
source.    The contents of the view are copied to the destination as a table.    Several of the dialog options 
can be pre-set by holding down combinations of SHIFT and CTRL when dropping the objects.    For a 
description of object levels see Hierarchical Display List.



Selection Display/Change Controls
These controls display which objects will be copied and where they will be copied to.

Selection Scroll Buttons - These are VCR-like buttons used to scroll through the list of selected 
objects.    These are the objects that were dropped on the destination Data Definition Window to 
open the Move/Copy Tables dialog.

Source/Destination Selection - These display the source and destination data source,    table owner 
and table name used for the operation.    The source table owner, source table name and 
destination table owner can be changed by selecting a new option in the proper combo box.    A 
new destination table name can be changed by both selecting a new option or by typing a new 
name in the proper combo box.



Status Indicators
These display the current operation as well as an event log of previous operations performed for the 
current copy/move task.    A current row count is also displayed when table rows are being copied.



Command Buttons
Start/Stop - This button starts a copy/move task from the currently displayed source object to the 

currently displayed destination object.    If a task is in progress,    the button caption will say "Stop" 
and when clicked will stop the current task and return the button caption to "Start".

Cancel - This button dismisses the Move/Copy Tables.

Options - This button displays the Table Copy Options.



Table Copy Options
Overview
Check Options
Result Set Control Options



Overview
This dialog is called from the Move/Copy Tables dialog.    Its purpose is to provide a high level of control 
over the copy/move task performed.



Check Options
Show Column Edit Dialog - When this is checked,    a dialog will display during a data copying 

operation to allow different column names to be used when the rows are inserted into the 
destination table.    This is primarily used in append operations to match up column names in the 
source table with column names in the destination table

Overwrite Destination Table - When this is checked,    the destination table will be dropped and re-
created with the column definitions of the source table.    Otherwise,    the destination table's 
definitions and data rows will remain intact and the source rows will be appended to the 
destination table.    If this is not checked,    the Copy Data Definitions Only options must not be 
checked either since definitions cannot be copied without overwriting the destination table.

Copy Data Definitions Only - When this is checked,    only data definitions are copied.    Otherwise, 
table rows are also copied.

Drop Source Tables When Completed - When this is checked,    the source table objects are 
dropped after being successfully copied.

Stop Between Tables - When this is checked,    only one table object will be copied when the Start 
button is clicked.    Otherwise,    the remaining objects in the selection list will be copied without 
stopping.



Result Set Control Options
These options allow the rows in the source table to be filtered before copying to the destination table.

Source Column List - This is a list of column names in the source table.    Selected list items can be 
selected and copied to the "Where" and "Order By" text boxes by using the Add buttons..

Where Clause Text Box - This allows text to be entered that will be used as an SQL WHERE clause 
to filter source table rows before copying them to the destination table.

Order By Text Box - This allows text to be entered that will be used as an SQL ORDER BY clause to 
sort source table rows before copying them to the destination table.



Grid View
Overview
Status Indicators
Command Buttons



Overview
This dialog is opened from the Result Menu on a    Query Window.    Its purpose is to control which result 
rows are displayed in the Result Grid.



Status Indicators
Grid Information - This displays the current size of the grid in rows and which result set rows are 

displayed in the grid.

Maximum Grid Size - This displays    the "Maximum Grid Rows" option setting.



Command Buttons
Ok - This button attempts to carry out the task currently selected in the option buttons and then 

dismisses the Grid View.

Cancel - This button dismisses the Grid View

Data Options - This button displays the Data Options.



General Options
Overview
Option Buttons
Command Buttons



Overview
This dialog is opened from the Option Menu on a    Query Window.    or a Data Definition Window.    Its 
purpose is to display a dialog to set various program options.    Options set in the dialog are stored 
permanently in the program's INI file



Option Buttons
Save Window Layout on Exit - When this is checked,    the program's exit procedure will save the 

position,    size    and connection status of each Data Definition Window and Query Window as 
well as the position and size of the application's frame window.

Restore Saved Window Layout on Startup - When this is checked,    the program's start-up 
procedure loads the last saved window state.

Enable Status Bar Help Messages - When this is checked,    the program will display help 
messages in the Status Bar.



Command Buttons
Ok - This button saves all option settings and dismisses the General Options.

Cancel - This button dismisses the General Options without saving any of the dialog settings.



Data Options
Overview
Option Buttons
Command Buttons



Overview
This dialog is opened from the Option Menu on a    Query Window.    or a Data Definition Window.    Its 
purpose is to display a dialog to set various program options.    Options set in the dialog are stored 
permanently in the program's INI file



Option Buttons
Maximum Grid Rows - This number dictates how many grid rows can be stored in the Result Grid .

Use ODBC driver's Auto-Commit Option - When this is checked,    the ODBC drivers will be set to 
automatically commit all SQL statements.



Command Buttons
Ok - This button saves all option settings and dismisses the Data Options.

Cancel - This button dismisses the Data Options without saving any of the dialog settings.




